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 MACROBUTTON  - [Report Date] 
Instructions for Use of This

Energy Analysis Report Template

This template is designed to provide a general and flexible guideline for preparation of an Energy Analysis Report. The preparer of any energy analysis reports using this template agrees that they are solely responsible for all language contained within this template.  Some template sections may not be applicable to your specific report.  In addition, your report may benefit from the inclusion of sections that are not outlined in this template.  It is important that you use your best judgment in adding and removing sections as is appropriate for your individual situation.

In this template, all text contained within [brackets] contains instructions or a summary of what to include in the section, and is designed to be replaced with specifics from your analysis.  For example, when you begin adapting the cover page, click on [Facility Name] and replace that generic placeholder with the name of your facility. Continue with [Facility Address], etc.  
This template includes headers and footers which will appear in your printed document.  The footer content automatically numbers the pages of the report, beginning with i, ii, etc. on pages between the cover sheet and the page where the Executive Summary begins.  Beginning with the Executive Summary page, the footer automatically numbers the pages 1, 2, etc.  It will be necessary for you to manually insert page numbers into the Table of Contents list, corresponding to the page on which each section can be found.   To edit the generic placeholders [Auditor], [Auditor Logo], and [Facility Name], which begin in the header and footer on Page 1, right-click on each field to “edit field”. To edit the header or footer in Word 2003, go to the “View” menu and select “Header and Footer”. From the created window you can insert auto text for variables like author and date. To edit the header or footer in Word 2007, click on the “Insert” tab, click on “Header” or “Footer”, and then choose “Edit Header” or “Edit Footer”.  When editing is complete, click on “Close Header and Footer” within the “Design” tab to return to the body of the report.
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DISCLAIMER – edit as required
The intent of this energy analysis report is to estimate energy savings associated with recommended upgrades to the systems at the analyzed facility.  Appropriate detail is included in this report to make decisions about implementing energy efficiency measures at the facility. However, this report is not intended to serve as a detailed engineering design document, as the description of the improvements are diagrammatic in nature only in order to document the basis of energy savings cost estimates, and to demonstrate the feasibility to implement the improvements. 
While the recommendations in this report have been reviewed for technical accuracy and are believed to be reasonably accurate, the findings are estimates and actual results may vary. The “auditing company” is not liable if projected estimated savings or economics are not actually achieved. All savings and cost estimates in the report are for informational purposes, and are not to be construed as a design document or as guarantees.

In no event will the “auditing company” be liable for the failure of the customer to achieve a specified amount of energy savings, any operational issues that arise in the customer’s facilities, or any incidental or consequential damages of any kind in conjunction with this report or the installation of recommended measures.
EXECUTIVE SUMMARY
 MACROBUTTON  - [Enter here an overview of the analysis results and recommendations.] 
 MACROBUTTON  - [Enter here a summary of proposed energy saving measures] 
 MACROBUTTON  - [Complete table below with energy savings measures] 
Recommended Energy Saving Measures and Estimated Savings

	Measure
	Description of Measure
	Annual Savings (kW)
	Annual Savings (kWh)
	Estimated Implementation Cost
	Simple Payback (years)
	Internal Rate of Return (%)

	Measure 1
	
	
	
	
	
	

	Measure 2
	
	
	
	
	
	

	Measure 3
	
	
	
	
	
	

	Measure 4
	
	
	
	
	
	


 MACROBUTTON - [Enter here a summary of any proposed Demand Response Measures] 
Recommended Demand Response Measures and Estimated Savings

	Measure
	Description of Measure
	Demand Reduction (kW)
	Annual Savings ($)
	Estimated Implementation Cost
	Simple Payback (years)
	Internal Rate of Return (%)

	Measure #
	
	
	
	
	
	

	Measure #
	
	
	
	
	
	


 MACROBUTTON  - [Enter here a summary of any proposed Self Generation Measures] 
Recommended Self Generation Measures and Estimated Savings

	Measure
	Description of Measure
	Generation Produced (kW)
	Annual Savings ($)
	Estimated Implementation Cost
	Simple Payback (years)
	Internal Rate of Return (%)

	Measure #
	
	
	
	
	
	

	Measure #
	
	
	
	
	
	


PROJECT INFORMATION

 MACROBUTTON - [Enter here a description of the project, including:] 
 MACROBUTTON - [Building description] 
 MACROBUTTON  - [Schedules, occupancy variation, usage patterns] 
Building Occupancy Schedule

	Area/ Zone
	Square Footage
	Weekdays
	Weekends / Holidays

	
	
	Hours
	# of People
	Hours
	# of People

	
	
	From
	To
	
	From
	To
	

	
	
	
	
	
	
	
	

	
	
	
	
	
	
	
	

	
	
	
	
	
	
	
	

	
	
	
	
	
	
	
	


HVAC Operating Schedule

	Day
	Equipment Operating Time

	Weekdays
	

	Weekends/Holidays
	


 MACROBUTTON - [Comfort and other operational requirements] 
 MACROBUTTON  - [Rate description and  billing data analysis] 
Summary of Electricity Usage:

	Month/Year
	Peak Demand (kW)
	Energy Usage (kWh)
	Avg. Daily Usage (kWh/day)
	Total Cost ($)
	Unit Cost ($/kWh)

	
	
	
	
	
	

	
	
	
	
	
	

	
	
	
	
	
	

	
	
	
	
	
	

	
	
	
	
	
	

	
	
	
	
	
	

	
	
	
	
	
	

	
	
	
	
	
	

	
	
	
	
	
	

	
	
	
	
	
	

	
	
	
	
	
	

	
	
	
	
	
	

	TOTAL
	
	
	
	
	


Summary of Natural Gas Usage:

	Month/Year
	Gas Usage (Therms)
	Avg. Usage (Therms/Day)
	Gas Cost ($)
	Unit Cost   ($/Therm)

	
	
	
	
	

	
	
	
	
	

	
	
	
	
	

	
	
	
	
	

	
	
	
	
	

	
	
	
	
	

	
	
	
	
	

	
	
	
	
	

	
	
	
	
	

	
	
	
	
	

	
	
	
	
	

	
	
	
	
	

	TOTAL
	
	
	
	


 MACROBUTTON  - [Provide benchmarking scores and explanation] 
Electricity Benchmarking
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Natural Gas Benchmarking
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 MACROBUTTON  - [Commercial Building End-Use Survey (CEUS) data] 
Electric Usage by End-Use
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Natural Gas Usage by End-Use
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 MACROBUTTON  - [Audit scope of work] 
 MACROBUTTON  - [Description of relevant lighting systems and controls] 
 MACROBUTTON  - [Optional: provide table of lighting equipment] 
Lighting

	Building Area
	Lamp Type Fixture Type
	Approximate Number of Fixtures
	Average Watts per Fixture
	Operating Hours/Day
	Average Foot-candles

	
	
	
	
	
	

	
	
	
	
	
	

	
	
	
	
	
	

	
	
	
	
	
	

	
	
	
	
	
	


 MACROBUTTON  - [Description of relevant mechanical systems and controls] 
 MACROBUTTON  - [Optional: provide table of mechanical equipment] 
Mechanical Equipment

	Equipment Name/Number
	Motor Use
	Area Served
	Motor Size (hp)
	Quantity of Motors
	Efficiency

	AHU-1
	Supply Fan
	
	
	
	

	
	
	
	
	
	

	
	
	
	
	
	

	
	
	
	
	
	

	
	
	
	
	
	


 MACROBUTTON  - [Description of relevant miscellaneous systems] 
 MACROBUTTON  - [Optional: provide table of miscellaneous equipment] 
Miscellaneous Equipment
	Equipment Name/Number
	Motor Use
	Area Served
	Load Used
	Quantity 
	Efficiency

	
	
	
	
	
	

	
	
	
	
	
	

	
	
	
	
	
	

	
	
	
	
	
	

	
	
	
	
	
	


 MACROBUTTON  - [Description of relevant envelope systems] 
 MACROBUTTON  - [Optional: provide table of glazing, insulation, and roof treatment] 
	
	Area (sq. ft.)
	Material Type
	Direction Facing

	Doors
	
	
	

	
	
	
	

	
	
	
	

	Glass
	
	
	

	
	
	
	

	
	
	
	


	
	Area (sq. ft.)
	Material Type
	Insulation Type
	Insulation Thickness

	Walls
	
	
	
	

	Roof
	
	
	
	


ENERGY SAVINGS MEASURES

NO-COST MEASURES

MEASURE  MACROBUTTON  - [#]  -  MACROBUTTON  - [Name of Measure #] 
 MACROBUTTON  - [Enter description of Measure #] 
 MACROBUTTON  - [Include photo, project savings, benefits, cost, incentives, financial analysis] 
	Measure
	Description of Measure
	Annual Savings (kW)
	Annual Savings (kWh)
	Estimated Implementation Cost
	Simple Payback (years)
	Internal Rate of Return (%)

	Measure #
	
	
	
	
	
	


Measure  MACROBUTTON  - [#]  -  MACROBUTTON  - [Name of Measure #] 
 MACROBUTTON  - [Enter description of Measure #] 
 MACROBUTTON - [Include photo, project savings, benefits, cost, incentives, financial analysis] 
	Measure
	Description of Measure
	Annual Savings (kW)
	Annual Savings (kWh)
	Estimated Implementation Cost
	Simple Payback (years)
	Internal Rate of Return (%)

	Measure #
	
	
	
	
	
	


LOW-COST MEASURES
Measure  MACROBUTTON  - [#]  -  MACROBUTTON  - [Name of Measure #] 
 MACROBUTTON  - [Enter description of Measure #] 
 MACROBUTTON - [Include photo, project savings, benefits, cost, incentives, financial analysis] 
	Measure
	Description of Measure
	Annual Savings (kW)
	Annual Savings (kWh)
	Estimated Implementation Cost
	Simple Payback (years)
	Internal Rate of Return (%)

	Measure #
	
	
	
	
	
	


Measure  MACROBUTTON  - [#]  -  MACROBUTTON  - [Name of Measure #] 
 MACROBUTTON  - [Enter description of Measure #] 
 MACROBUTTON  - [Include photo, project savings, benefits, cost, incentives, financial analysis] 
	Measure
	Description of Measure
	Annual Savings (kW)
	Annual Savings (kWh)
	Estimated Implementation Cost
	Simple Payback (years)
	Internal Rate of Return (%)

	Measure #
	
	
	
	
	
	


INVESTMENT-GRADE MEASURES

Measure  MACROBUTTON  - [#]  -  MACROBUTTON  - [Name of Measure #] 
 MACROBUTTON  - [Enter description of Measure #] 
 MACROBUTTON  - [Include photo, project savings, benefits, cost, incentives, financial analysis] 
	Measure
	Description of Measure
	Annual Savings (kW)
	Annual Savings (kWh)
	Estimated Implementation Cost
	Simple Payback (years)
	Internal Rate of Return (%)

	Measure #
	
	
	
	
	
	


Measure  MACROBUTTON  - [#]  -  MACROBUTTON  - [Name of Measure #] 
 MACROBUTTON  - [Enter description of Measure #] 
 MACROBUTTON  - [Include photo, project savings, benefits, cost, incentives, financial analysis] 
	Measure
	Description of Measure
	Annual Savings (kW)
	Annual Savings (kWh)
	Estimated Implementation Cost
	Simple Payback (years)
	Internal Rate of Return (%)

	Measure #
	
	
	
	
	
	


DEMAND RESPONSE STRATEGIES 
 MACROBUTTON - [an optional section that may or may not apply] 
DR  MACROBUTTON  - [#]  -  MACROBUTTON  - [Name of DR #] 
 MACROBUTTON  - [Enter description of DR #] 
 MACROBUTTON  - [Include photo, project savings, benefits, cost, incentives, financial analysis] 
	Measure
	Description of Measure
	Demand Reduction (kW)
	Annual Savings ($)
	Estimated Implementation Cost
	Simple Payback (years)
	Internal Rate of Return (%)

	Measure #
	
	
	
	
	
	


DR  MACROBUTTON  - [#]  -  MACROBUTTON  - [Name of DR #] 
 MACROBUTTON  - [Enter description of DR #] 
 MACROBUTTON  - [Include photo, project savings, benefits, cost, incentives, financial analysis] 
	Measure
	Description of Measure
	Demand Reduction (kW)
	Annual Savings ($)
	Estimated Implementation Cost
	Simple Payback (years)
	Internal Rate of Return (%)

	Measure #
	
	
	
	
	
	


PROPOSED SELF-GENERATION OPPORTUNITIES 
 MACROBUTTON - [an optional section that may or may not apply] 
SG  MACROBUTTON  - [#]  -  MACROBUTTON  - [Name of SG #] 
 MACROBUTTON  - [Enter description of SG #] 
 MACROBUTTON  - [Include photo, project savings, benefits, cost, incentives, financial analysis] 
	Measure
	Description of Measure
	Generation Produced (kW)
	Annual Savings ($)
	Estimated Implementation Cost
	Simple Payback (years)
	Internal Rate of Return (%)

	Measure #
	
	
	
	
	
	


SG  MACROBUTTON  - [#]  -  MACROBUTTON  - [Name of SG #] 
 MACROBUTTON  - [Enter description of SG #] 
 MACROBUTTON  - [Include photo, project savings, benefits, cost, incentives, financial analysis] 
	Measure
	Description of Measure
	Generation Produced (kW)
	Annual Savings ($)
	Estimated Implementation Cost
	Simple Payback (years)
	Internal Rate of Return (%)

	Measure #
	
	
	
	
	
	


MEASURES ANALYZED BUT NOT RECOMMENDED

Measure  MACROBUTTON  - [#]  -  MACROBUTTON  - [Name of Measure #] 
 MACROBUTTON  - [Enter description of Measure #] 
 MACROBUTTON  - [Include photo, project savings, benefits, cost, incentives, financial analysis] 
	Measure
	Description of Measure
	Annual Savings (kW)
	Annual Savings (kWh)
	Estimated Implementation Cost
	Simple Payback (years)
	Internal Rate of Return (%)

	Measure #
	
	
	
	
	
	


Measure  MACROBUTTON  - [#]  -  MACROBUTTON  - [Name of Measure #] 
 MACROBUTTON  - [Enter description of Measure #] 
 MACROBUTTON  - [Include photo, project savings, benefits, cost, incentives, financial analysis] 
	Measure
	Description of Measure
	Annual Savings (kW)
	Annual Savings (kWh)
	Estimated Implementation Cost
	Simple Payback (years)
	Internal Rate of Return (%)

	Measure #
	
	
	
	
	
	


APPENDICES
 MACROBUTTON - [Provide supporting information including:] 
 MACROBUTTON - [Calculations] 
 MACROBUTTON  - [Documentation on assumptions] 
 MACROBUTTON - [Implementation notes] 
 MACROBUTTON - [Emission reductions] 
 MACROBUTTON  - [Measurement and verification protocols] 
DELETE THE CONTENTS OF THIS INSTRUCTION PAGE PRIOR TO COMPLETION OF YOUR REPORT








